
C H A P T E R

4-1
Cisco 無線 IP 電話 7920 アドミニストレータ ガイド Cisco CallManager Release 4.0 及び 4.1

OL-7104-01-J

4

Cisco 7920設定ユーティリティ
の使用方法

この章では、Cisco 無線 IP 電話 7920 のネットワーク設定値および電話設定値を

設定するために、Cisco 7920 設定ユーティリティ バージョン 2.0 のインストール

方法および使用方法について説明します。次の項で、ユーティリティのインス

トール方法と使用方法について説明します。

• Cisco 7920 設定ユーティリティのインストール方法（P.4-2）

• Cisco 7920 設定ユーティリティの使用方法（P.4-5）

• アプリケーション ウィンドウの概要（P.4-8）

Cisco 無線 IP 電話 7920 で Network Configuration メニューを使用して、ネットワー

ク設定値を設定することもできます。第 5 章「Cisco 無線 IP 電話 7920 のネット

ワーク プロファイルの設定」を参照してください。
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Cisco 7920 設定ユーティリティのインストール方法
ここでは、Cisco 7920 設定ユーティリティ バージョン 2.0 とそのコンポーネント

をインストールする方法について説明します。

• システム要件（P.4-2）

• Cisco 7920 設定ユーティリティのインストール（P.4-3）

• Cisco 7920 設定ユーティリティのアンインストール（P.4-4）

システム要件

Cisco 7920 設定ユーティリティをインストールして実行するには、対象のコン

ピュータは次のハードウェア要件およびソフトウェア要件を満たす必要があり

ます。

ハードウェア要件

• Microsoft Windows を実行する IBM 互換パソコン（PC）

• CD-ROM ドライブ

• キーボード、マウス、またはその他のポインティング デバイス

• USB ポートとケーブル

（注） USB ケーブルを使用して、Cisco 7920 設定ユーティリティを実行してい
る PC を電話機に接続します。設定ユーティリティ ソフトウェアに付属
の専用 USB ケーブルまたは標準 USB ケーブル（タイプ 2）が付いたデ
スクトップ充電器を使用できます。

ソフトウェア要件

PC で次のオペレーティング システムのいずれかを使用します。

• Windows 98（Second Edition）

• Windows ME

• Windows 2000 Professional（SP1 以降）

• Windows XP（Home Edition または Professional）
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また、次のソフトウェアをインストールする必要があります。

• Cisco 7920 設定ユーティリティ バージョン 2.0

• Cisco 無線 IP 電話 7920 ファームウェア リリース 2.0

（注） Cisco 7920 設定ユーティリティ 2.0 は、Cisco 無線 IP 電話 7920 ファームウェア リ
リース 2.0 だけをサポートします。電話機で 2.0 より前のファームウェア バー

ジョンを使用している場合は、以前のバージョンの設定ユーティリティを使用す

る必要があります。

関連項目

• Cisco 7920 設定ユーティリティのインストール（P.4-3）

• Cisco 7920 設定ユーティリティのアンインストール（P.4-4）

Cisco 7920 設定ユーティリティのインストール

CD を使用するか、または Cisco Software Download Center からソフトウェアをダ

ウンロードすることにより、Cisco 7920 設定ユーティリティをインストールでき

ます。

Cisco 7920 設定ユーティリティをインストールする手順は、次のとおりです。

手順

ステップ 1 Cisco 7920 設定ユーティリティ CD を CD-ROM ドライブに挿入するか、または

ソフトウェアをダウンロードします。

ステップ 2 setup.exe ファイルをダブルクリックします。InstallShield Wizard ウィンドウが表

示されます。

ステップ 3 InstallShield ウィザードは、インストール プロセスを実行するための手順を示し

ます。Next をクリックして続行し、画面の指示に従います。
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ステップ 4 インストールが完了したら Finish をクリックします。

インストール中に、次のファイルが指定された場所にコピーされます。

• Cisco7920.exe：メイン実行可能プログラム

• Expat.dll：XML パーサー

• <Cisco 7920 USB>：Cisco 無線 IP 電話 7920 対応の USB ドライバ

（注） ファイルはデフォルトで次のディレクトリ パスにインストールされま
す。
C:\Program Files\Cisco\Cisco7920ConfigurationUtility\Cisco 7920 USB 

Cisco 7920 設定ユーティリティのアンインストール

Cisco 7920 設定ユーティリティをアンインストールするには、Windows の［コン

トロール パネル］の［アプリケーションの追加と削除］を使用します。

関連項目

• Cisco 7920 設定ユーティリティのインストール方法（P.4-2）
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Cisco 7920 設定ユーティリティの使用方法
ここでは、Cisco 7920 設定ユーティリティの使用方法に関する次の情報について

説明します。

• Cisco 7920 設定ユーティリティの概要（P.4-5）

• 電話機への Cisco 7920 設定ユーティリティの接続（P.4-5）

Cisco 7920 設定ユーティリティの概要

Cisco 7920 設定ユーティリティを使用して、Cisco 無線 IP 電話に使用可能な設定

値をすべて設定できます。Cisco 7920 設定ユーティリティの使用を開始するに

は、次の作業が完了している必要があります。

• USB ケーブルを使用して、Cisco 7920 設定ユーティリティがインストールさ

れた PC に電話機を接続している。 

• 電話機の USB ポートが設定ユーティリティ プログラムと通信できるように

なっている。

• 電話機への接続とログインが確立されている。

• Configuration Wizard を使用して電話機が設定されている。詳細については、

P.4-16 の「Configuration Wizard の使用方法」を参照してください。

• 上級者の場合、Phone Profiles ウィンドウとタスク ボタンを使用して、電話

の設定値を設定できます。詳細については、P.4-18 の「Phone Profile ウィン

ドウ」を参照してください。

電話機への Cisco 7920 設定ユーティリティの接続

USB ケーブルを使用して、Cisco 7920 設定ユーティリティを実行しているコン

ピュータに電話機を接続します。ソフトウェアに付属の専用 USB ケーブルまた

は標準 USB ケーブル（タイプ 2）が付いたデスクトップ充電器を使用できます。

（注） ソフトウェアに付属の専用 USB ケーブルまたは標準 USB ケーブル（タ
イプ 2）が付いたデスクトップ充電器を使用できます。
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電話機で USB ポートをアクティブにするには、電話機の Phone Settings メニュー

にアクセスする必要があります。次の項で、電話機への接続に役立つ情報につい

て説明します。

• 電話機の USB ポートのアクティブ化（P.4-6）

• Cisco 無線 IP 電話への接続（P.4-6）

電話機の USB ポートのアクティブ化

電話機で Cisco 7920 設定ユーティリティを使用するには、電話機に接続する前に

USB ポートをアクティブにする必要があります。

手順

ステップ 1 Cisco 無線 IP 電話 7920 の電源をオンにします。

ステップ 2 電話機の USB ポートを有効にするには、Menu ソフトキーを押し、Phone Settings

> USB Enable/Disable > Enable を選択します。 

ステップ 3 USB ケーブルを使用して、PC と Cisco 無線 IP 電話 7920 を接続します。

Cisco 無線 IP 電話への接続

USB ポートを有効にしたら、次の手順に従って、電話機にログインできます。

（注） USB を使用して電話機に接続できるようにするには、PC にあるローカ
ル ファイアウォールをすべて無効にする必要があります。
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手順

ステップ 1 アプリケーションを起動するには、［スタート］>［プログラム］> Cisco Systems

7920 > Cisco 7920 Configuration Utility を選択します。

設定ユーティリティが自動的に Connection > Login を実行し、Cisco 無線 IP 電話

7920 が PC に接続されます。 

ステップ 2 Login ウィンドウで、デフォルトのユーザ名 Admin を選択し、パスワード cisco

を入力します（オンライン インジケータについては、P.4-10 の「接続ステータ

ス バー情報」を参照してください）。 

（注） 管理者のパスワードを変更するには、Edit > Change Admin Password を
選択します。

その後、7920 設定ユーティリティにより電話設定データが Current Phone Settings

ウィンドウにロードされます。 

ステップ 3 既存の電話設定を変更するには、P.4-18 の「Phone Profile ウィンドウ」を参照し

てください。

（注） 電話機への接続に関して問題がある場合は、P.4-42 の「Cisco 7920 設定ユーティ

リティのネットワーク接続のトラブルシューティング」を参照してください。
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アプリケーション ウィンドウの概要
Cisco 7920 設定ユーティリティのグラフィカル ユーザ インターフェイスには、次

のウィンドウが表示されます。これらのウィンドウでは、新しい電話機を追加し

たり、既存の電話機を変更したりすることができます。

• Current Phone Settings：現在の電話機の設定に関する情報が表示されます。 

• Configuration Wizard：順を追って電話機を設定するガイドが表示されます。

• Phone Profile：カテゴリ タブ ページで構成された設定フィールドが表示され

ます。

• Log History：ファイル内の電話設定イベントをキャプチャします。

ここでは、設定ユーティリティのユーザ インターフェイスとメニュー オプショ

ンについて説明します。内容は次のとおりです。

• Current Phone Settings ウィンドウ（P.4-8）

• Configuration Wizard の使用方法（P.4-16）

• Phone Profile ウィンドウ（P.4-18）

• Log History ウィンドウ（P.4-41）

Current Phone Settings ウィンドウ

図 4-1 は、設定ユーティリティが電話機に接続したときに表示される Current

Phone Settings ウィンドウです。電話設定のフィールド値は表示のみです。設定

ファイルを変更するには、Configuration Wizard ウィンドウまたは Phone Profile

ウィンドウを使用する必要があります。
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図 4-1 Cisco 7920 設定ユーティリティ：Current Phone Settings ウィンドウ
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接続ステータス バー情報

Connection メニュー オプションを使用して電話機にログインすると、左下の LED

インジケータに現在の接続ステータスが表示されます（表 4-1 を参照）。

設定ユーティリティ メニューの使用方法

設定ユーティリティには、次のメニュー オプションがあります。

File メニュー オプション

File メニューには、次の標準 Windows オプションがあります。

• New：電話機の新しい設定ファイルを開きます。

• Open：既存の設定ファイルを探して開きます。

• Save：設定ファイルの変更を保存します。

表 4-1 接続ステータス

ステータス 
インジケータ 操作 説明

Connection  > Login を選択します。

インポート、エクスポート、または

ファームウェア イメージのアップロー

ド オプションを選択します。

電話機は接続中です。

インポート、エクスポート、または

ファームウェア イメージのアップロー

ド オプションを実行しているとき、接

続は実行中になります。

メニュー バーから Connection > Login

を選択します。

電話機はオンラインであり、接続が確立

されています。

インポート、エクスポート、および

ファームウェア イメージのアップロー

ド オプションを実行できます。

Connection > Logout を選択します。

USB ケーブルを取りはずします。

電話機はオフラインです。

インポート、エクスポート、または

ファームウェア イメージのアップロー

ド オプションは実行できません。
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• Save As：設定ファイルに新しいファイル名を付けて変更を保存します。

• Exit：アプリケーションを閉じます。

Edit メニュー オプション

Edit メニューには、次の標準 Windows 編集オプションがあります。

• Cut

• Copy

• Paste

Edit メニューから次のオプションにアクセスできます。

• Configuration Wizard および Phone Profile

• Change Admin Password

View メニュー オプション

設定ユーティリティが起動されると、Current Phone Settings ウィンドウおよび

Log History ウィンドウが自動的に表示されます。View メニューを使用して、次

のウィンドウを切り替えたり、Toolbar や Status Bar の表示または非表示を切り替

えたりすることができます。

• Current Phone Settings

• Log History

• Toolbar

• Status Bar

Connection メニューの使用方法

Connection メニューを使用して、設定ユーティリティで次の作業を実行できま

す。

• ログイン（P.4-12）

• 管理者パスワードの変更（P.4-12）

• ログアウト（P.4-13）

• ファームウェア イメージのアップロード（P.4-14）

• 出荷時のデフォルト値にリセット（P.4-15）
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ログイン

インポート、エクスポート、またはファームウェアのアップロードを実行するに

は、電話にログインする必要があります。 

電話にログインする手順は、次のとおりです。

手順

ステップ 1 メニュー バーから Connection > Login を選択します。 

Login ウィンドウが表示されます。

ステップ 2 ユーザ名とパスワードを入力します。デフォルトのユーザ名およびパスワード

は、表 4-2 に示すとおりです。

（注） キーロック パスワードを変更しなかった場合、デフォルトのユーザ パスワード

を使用して電話機をロック解除できます。ユーザがパスワードを変更し、それを

思い出せない場合は、Technical Assistance Center（TAC）に連絡して、電話機を

リセットする必要があります。

管理者パスワードの変更

初めて設定ユーティリティを起動したときに、ローカル コンピュータの Cisco

7920 設定ユーティリティのパスワードを変更する必要があります。管理者パス

ワードを変更するには、管理者権限でログインする必要があります。

表 4-2 デフォルトのユーザ名およびパスワード

ユーザ名 パスワード 認証

Admin cisco 設定ユーティリティ

User 12345 Cisco 無線 IP 電話 7920
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管理者パスワードを変更する手順は、次のとおりです。

手順

ステップ 1 Edit > Change Admin Password を選択して、Change Admin Password ウィンドウ

を表示します。

ステップ 2 New Password フィールドに、新規パスワードを入力します。

ステップ 3 Verify New Password フィールドに、新規パスワードを入力します。

ステップ 4 OK をクリックします。

ログアウト

ログアウトすると Cisco 無線 IP 電話 7920 が PC から切断され、設定ファイルの

インポート、エクスポート、または電話機へのファームウェア イメージのアッ

プロードができなくなります。

USB ケーブルを切断すると、自動的にログアウトされます。オンライン モード

で別の電話機に切り替えると、設定ユーティリティから自動的にログアウトしま

す。

ログアウトするには、次の手順に従います。

手順

ステップ 1 メニュー バーから Connection > Logout を選択します。 

Logout ウィンドウが表示されます。

ステップ 2 ログアウトを確認するには、Yes をクリックします。
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ファームウェア イメージのアップロード

Upload Firmware Image ウィンドウでは、ファームウェア イメージのファイル名

を指定し、このファイルを Cisco 無線 IP 電話 7920 にアップロードします。

ファームウェアをアップロードする手順は、次のとおりです。

手順

ステップ 1 ログインするには、メニュー バーから Connection > Login を選択します。 

ステップ 2 ユーザ名とパスワードを入力します。P.4-12 の「ログイン」を参照してください。

ステップ 3 Connection > Upload Firmware Image を選択します。

ステップ 4 アップロードするファームウェア イメージのファイル名とパスを入力または選

択します。

ステップ 5 ファームウェア イメージがアップロードされた後、Cisco 無線 IP 電話 7920 が自

動的にリブートされ、履歴ログに uploading firmware image イベントが記録されま

す。

ステップ 6 設定ユーティリティを使用して Cisco 無線 IP 電話 7920 の設定を続行するには、

再度ログインする必要があります。

注意 Cisco CallManager のファームウェア イメージのバージョンが、電話機にアップ

ロードしたファームウェアのバージョンと同じであることを確認してください。 
Cisco CallManager サーバのファームウェアのバージョンが異なっている場合、次

に電話機が Cisco CallManager に接続したときに、Cisco CallManager からそのバー

ジョンのファームウェアがダウンロードされます。
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出荷時のデフォルト値にリセット

設定を出荷時のデフォルト値に復元した場合、通話履歴、プロファイル設定な

ど、Cisco 無線 IP 電話 7920 のすべての設定が元の設定に変更されます。短縮ダ

イヤル設定はすべて削除されますが、電話帳に保存したデータは残ります。 

デフォルト設定値に復元する手順は、次のとおりです。

手順

ステップ 1 メニュー バーから Connection > Restore to Factory Default を選択します。 

ステップ 2 デフォルトへの復元を確認するには、Yes をクリックします。

ステップ 3 出荷時のデフォルト設定が復元された後、Cisco 無線 IP 電話 7920 は自動的に電

源がオフになります。

ステップ 4 Phone Profile ウィンドウを使用して、カスタム ネットワーク設定を再設定する必

要があります。詳細については、P.20 の「Network Profile の設定」を参照してく

ださい。

関連項目

• Configuration Wizard の使用方法（P.4-16）

• Phone Profile ウィンドウ（P.4-18）
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Configuration Wizard の使用方法

Cisco 無線 IP 電話を初めて設定する管理者のために、Configuration Wizard には順

を追ったガイドと、さまざまなネットワーク設定値と電話設定値に関する詳細情

報が表示されます。

ウィザードの使用を開始する手順は、次のとおりです。

手順

ステップ 1 Configuration Wizard にアクセスするには、Edit > Configuration Wizard を選択し

ます。 

Phone Profile ウィンドウの上部に Configuration Wizard ウィンドウが表示されま

す（図 4-2 を参照）。

ステップ 2 Configuration Wizard メイン ページで、次の電話設定のカテゴリのいずれかを選

択します。

• Network Profile

• Phone Settings

• User Profile

• Phone Lock Password

• Phone Book

• Speed Dial

Configuration Wizard に、カテゴリの設定手順およびエントリ フィールドの説明

が表示されます。 

ステップ 3 フィールドに入力し、Finish をクリックします。値と設定が Phone Profile ウィン

ドウの対応するタブ ページに表示されます。

ステップ 4 ボタン（Back、Finish、または Cancel）を使用して、設定手順を進めていきます。
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図 4-2 Network Profile の Configuration Wizard の手順

関連項目

• Current Phone Settings ウィンドウ（P.4-8）

• Phone Profile ウィンドウ（P.4-18）
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Phone Profile ウィンドウ

上級者の場合、図 4-3 に示す Phone Profile ウィンドウを使用できます。Phone

Profile ウィンドウを開くには、Edit > Configuration Wizard または File > New を

選択します。

図 4-3 Phone Profile ウィンドウ

タスク ボタン

Phone Profile ウィンドウの下部には、次の設定機能に簡単にアクセスできるタス

ク ボタンが表示されます。

• 電話設定のインポート

• 電話設定のエクスポート

• 別の電話機への変更
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電話設定のインポート

Import ボタンをクリックすると、USB ポートを介して接続された Cisco 無線 IP

電話 7920 から設定を取得します。インポートされた設定は、Phone Profile ウィ

ンドウの関連する設定タブに適用されます。

電話設定のエクスポート

Export ボタンをクリックすると、接続された Cisco 無線 IP 電話 7920 の設定を更

新します。電話設定が設定ファイルの設定値ですべて上書きされることに注意し

てください。 

（注） 電話機にエクスポートする設定ファイルのフィールドを空白のままにすると、電

話帳エントリなど、既存のエントリが消去されます。 

別の電話機への変更

管理者は Change Phone ボタンを使用して、再ログインすることなく別の電話機

に切り替えることができます。 

別の電話機に変更する手順は、次のとおりです。

手順

ステップ 1 Change Phone ボタンをクリックします。

ステップ 2 無線 IP 電話から USB ケーブルを取り外します。オンライン ステータス インジ

ケータが赤に変わり、Offline と表示されます。

（注） Windows 2000 を使用している場合は、電話機から USB ケーブルを抜く

前に Windows ステータス バーの［ハードウェアの取り外し］アイコン

（ ）をクリックします。

ステップ 3 次の無線 IP 電話機に USB ケーブルを差し込むか、または電話機をデスクトップ

充電器に差し込みます。
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ステップ 4 電話機の USB ポートが有効になっていることを確認します。P.4-6 の「電話機の

USB ポートのアクティブ化」を参照してください。

ステップ 5 インターフェイスがアクティブになるまでしばらく待機し、OK をクリックしま

す。オンライン ステータス インジケータが緑色になります。

関連項目

• Phone Profile ウィンドウの使用方法（P.4-20）

• Configuration Wizard の使用方法（P.4-16）

Phone Profile ウィンドウの使用方法

Phone Profile ウィンドウのタブから、次の作業を実行できる設定ウィンドウにア

クセスできます。

• Network Profile の設定（P.4-20）

• 電話設定値の設定（P.4-28）

• ユーザ プロファイルの設定（P.4-32）

• 電話帳の設定（P.4-37）

• 電話機のロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

Network Profile の設定

Network Profile タブ ページでは、電話機のネットワーク プロファイルを最大 4 つ

まで設定できます。各プロファイルに名前を付けて、特定の SSID の設定値を入

力できます。たとえば、最も頻繁にアクセスされる SSID および WLAN の場所

に対して Profile 1 を設定します。ネットワーク内の別の場所またはオフィスの

WLAN にアクセスするために、他のプロファイルを設定できます。

ネットワーク プロファイルには、次のタイプのパラメータおよび設定値が含ま

れます。

• システム パラメータ

• RF ネットワーク設定

• ネットワーク セキュリティ設定
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プロファイルへの名前付けとプロファイル アトリビュートの設定

簡単に識別できるように、プロファイルに一意の名前を付けることができます。 

さらに、プロファイルを自動的に選択するように電話機を設定したり、アクティ

ブなプロファイルを指定したりすることもできます。ネットワーク プロファイ

ルを変更できるかどうかを制御できます。

これらのオプションを設定する手順は、次のとおりです。

手順

ステップ 1 Phone Profiles ウィンドウで、Network Profiles タブをクリックします。

ステップ 2 変更するプロファイルの Profile ボタンをクリックします。

ステップ 3 Profile Name フィールドに、選択したプロファイルの名前（最大 20 文字）を入力

します。

ステップ 4 アクティブなプロファイルに設定するには、アクティブにするプロファイルの下

にあるオプション ボタンをクリックします。

（注） 複数のプロファイルをアクティブに設定するには、Auto 設定値を使用し
ます。電話機は Profile 1 から、ネットワーク プロファイルをすべてス
キャンします。最も優先度の高いプロファイル（1 が最高で 4 が最低）が
使用され、アクセス ポイントから応答を受けるまでスキャンします。

ステップ 5 ユーザがこのプロファイルを変更できるようにするには、Profile Modifiable 

チェックボックスをオンにします。

チェックボックスをオフのままにすると、ユーザはこのプロファイルに対する変

更を制限されます。設定ユーティリティを使用した場合のみ、このフィールドを

リセットできます。
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システム パラメータの設定値

System Parameter セクションには、DHCP を有効化または無効化するオプション

と、TFTP を設定するオプションが表示されます。

ネットワークで DHCP を使用する場合は、DHCP クライアントを有効にして、

IP アドレスを Cisco 無線 IP 電話に動的に割り当てます。この操作により、DHCP

サーバから情報を自動的に取得できます。DHCP クライアントを無効にする場合

は、IP アドレス、サブネット マスク、およびその他の IP 設定にスタティック IP

設定を指定する必要があります。 

また、DHCP で TFTP サーバを判別したり、特定の TFTP サーバの IP アドレスを

割り当てたりすることも選択できます。

DHCP クライアントの有効化または無効化

DHCP クライアントを有効または無効にする手順は、次のとおりです。

手順

ステップ 1 設定しているプロファイルの System Parameter エリアに移動します。

ステップ 2 次のいずれかの DHCP 設定を選択します。

• DHCP クライアントを有効にするには、DHCP Client チェックボックスを
チェックします。

Static IP Settings オプションは使用できません。

• DHCP クライアントを無効にするには、DHCP Client チェックボックスをオ
フにします。

これで、Static IP Settings オプションを使用できるようになります。

ステップ 3 DHCP Client オプションの下で、次のスタティック IP 設定を入力します。 

• IP Address：Cisco 無線 IP 電話 7920 の IP アドレスを入力します。

• Subnet Mask：サブネットワークを識別するための IP サブネット マスク アド
レスを入力し、LAN 上で IP アドレスが認識されるようにします。 
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• Primary TFTP Server：ファイルの場所を識別するための TFTP サーバ アドレ
スを入力します。Cisco 無線 IP 電話 7920 の設定ファイルとファームウェア
イメージは、TFTP サーバに配置します。

• Primary Gateway IP Address：プライマリ ゲートウェイ アドレスを入力しま
す。プライマリ ゲートウェイ アドレスにより、パケットの転送先となる次
のネットワーク ポイントが決定されます。 

• Primary DNS Server：DNS サーバのアドレスを入力します。DNS は、イン
ターネット ドメイン名を IP アドレスに変換します。 

• Secondary DNS Server：バックアップ DNS サーバのアドレスを入力します。 

TFTP オプションの設定

電話機の TFTP サーバへのアクセス方法を設定する手順は、次のとおりです。

手順

ステップ 1 設定しているプロファイルの System Parameter エリアに移動します。

ステップ 2 TFTP Option グループに関する次のいずれかの設定を選択します。

• DHCP サーバが TFTP サーバを判別できるようにするには、Use DHCP をク
リックします。

• プライマリ TFTP サーバの IP アドレスを指定するには、Use Static オプショ
ン ボタンをクリックします。Primary TFTP Server IP address フィールドがア
クティブになります。

ステップ 3 Use Static を選択した場合、TFTP サーバの IP アドレスを入力する必要がありま

す。
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RF ネットワーク設定値の設定

Network Profiles ウィンドウの RF Network セクション（RF は無線周波数の略）を

使用して、電話機に関する次の無線ネットワーク設定値を設定できます。

• Transmit power：無線送信電力レベルをミリワット（mW）単位で表した値。

• Data rate：データ転送レートをメガビット / 秒（Mbps）で表した値。

• Service Set Identifier（SSID）：相互に通信する無線デバイスのセットの識別

子。複数のアクセス ポイントが同じ SSID を使用することによって、無線電

話のグループをサポートできます。

• WPA Pre-shared Key：アクセス ポイントおよび電話機で設定されたパスワー

ド フレーズ。16 進数の文字列または ASCII パスワード フレーズのいずれか

が使用されます。この設定値の詳細については、P.2-18 の「認証方式および

暗号化方式の選択」を参照してください。

RF ネットワーク設定を構成する手順は、次のとおりです。

手順

ステップ 1 設定しているプロファイルの RF Network エリアに移動します。

ステップ 2 Transmit Power を設定するには、ドロップダウン リストの矢印をクリックして、

適切な電力設定を選択します（デフォルト設定は 20mW）。

（注） アクセス ポイントで Client Transmit Power が設定されている場合、電話
機は、アクセス ポイントが無線 LAN にブロードキャストする電力設定
を自動的に使用します。アクセス ポイントが最大値（Max）に設定され
ている場合、アクセス ポイントは電話機の Transmit Power 設定を使用し
ます。
Dynamic Transmit Power Control（DTPC; 送信電力の動的制御）は、ファー
ムウェア リリース 1.08 以降で使用可能です。

ステップ 3 Data Rate を設定するには、ドロップダウン リストの矢印をクリックして、適切

なデータ レート設定を選択します（アクセス ポイントが通知したデータ レート

を使用している場合、デフォルトは Automatic です）。
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（注） データ レート設定値は、電話機が使用する最大レートです。11 mbps に
設定すると、電話機はネットワークのトラフィック タイプに応じて、1、
2、5.5 または 11 mbps で送信できます。 
Automatic に設定すると、電話機はアクセス ポイントの設定で指定され
たデータ レートを使用します。

ステップ 4 SSID 設定を入力するには、ドロップダウン リストの矢印をクリックして、次の

いずれかを選択します。

• Any：ネットワークで SSID をブロードキャストしているアクセス ポイント
を使用します。 

• Specify：SSID を指定します。 

ステップ 5 Specify を選択する場合は、32 桁までの SSID をフィールドに入力します。 

（注） SSID は大文字と小文字が区別されます。アクセス ポイントで設定した
とおりに、文字を正しく入力してください。

ステップ 6 WPA Pre-shared Key を入力するには、次のパスワード形式（16 進数または ASCII）

のオプション ボタンをクリックし、パスワード フレーズを入力します。

• Hexadecimal：16 進数形式（0 ～ 9、A ～ F）で 64 文字必要。

• ASCII：ASCII 形式で 8 ～ 63 文字必要。0 ～ 9、A ～ Z（大文字と小文字）、
および /、*、% などの記号を使用できます。

（注） WPA Pre-shared key を設定するには、認証タイプも AKM に設定する必要
があります。P.4-26 の「ネットワーク セキュリティ設定値の設定」を参
照してください。
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ネットワーク セキュリティ設定値の設定

Network Profile ウィンドウの Network Security セクションを使用して、セキュリ

ティ設定用の認証タイプと暗号を選択できます。これらのオプションの設定の詳

細については、P.5-14 の「認証および暗号化の設定値の選択」を参照してくださ

い。

認証タイプ

次の種類の認証を設定できます。

• オープン：アクセス ポイントに自由にアクセスできます。オプションで、必

要に応じて暗号化タイプを静的 Wired Equivalent Privacy（WEP）Key に設定

できます。

• 共有キー：ローカル アクセス ポイントの Shared Key セキュリティ オプショ

ンを有効にします。Shared Key 認証タイプを設定したら、暗号化タイプを静

的 WEP Key に設定する必要があります。

• LEAP：Cisco Light Extensible Authentication Protocol（LEAP）を有効にしま

す。これは、WLAN 環境で中央 RADIUS サーバを使用する無線デバイスの

認証用に設計された、シスコの専用プロトコルです。 

• AKM：Authenticated Key Management（AKM）を有効にします。この操作に

より、アクセス ポイントによる選択に基づいて、電話機でアクセス ポイン

トおよびキー管理方式のタイプ（WPA、CCKM、または WPA Pre-shared Key）
を選択できます。 

認証タイプを設定する手順は、次のとおりです。

手順

ステップ 1 設定しているプロファイルの Network Security エリアで、Authentication Type エリ

アに移動します。

ステップ 2 次のいずれかの認証タイプ設定を選択します。

• オープン：Open オプション ボタンをクリックし、アクセス ポイントと電話
機の間のセキュリティを有効にします。

• 共有キー：Shared Key オプション ボタンをクリックし、アクセス ポイント
と電話機の間のセキュリティを有効にします。
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• LEAP：LEAP オプション ボタンをクリックし、設定フィールドにアクセス
します。ネットワーク アクセス サーバ（RADIUS サーバ）に対して許可さ
れたユーザ名およびパスワードを指定します。各ユーザ名およびパスワード
の最大長は 32 文字です。

• AKM：AKM オプション ボタンをクリックし、設定フィールドにアクセス
します。CCKM または WPA を使用している場合、ネットワーク アクセス
サーバ（RADIUS サーバ）に対して許可されたユーザ名およびパスワードを
指定する必要があります。各ユーザ名およびパスワードの最大長は 32 文字
です。

（注） WPA Pre-shared key を使用している場合、パスワード フレーズも設
定する必要があります。P.4-24 の「RF ネットワーク設定値の設定」
を参照してください。

ステップ 3 アクセス ポイントで認証する前にユーザにパスワードの入力を求めるには、

Prompt Mode チェックボックスをオンにします。プロンプト モードを無効にす

るには、このチェックボックスをオフのままにします。

暗号化タイプ

オープン認証または共有キー認証で WEP 暗号化を使用することもできます。共

有キー認証タイプを選択する前に、Wired Equivalent Privacy（WEP）キーを設定

する必要があります。Cisco 無線 IP 電話 7920 には 4 つまでの WEP キーを設定で

きます。暗号化キーには、16 進数の文字を使用する 40 ビット キーおよび 128

ビット キーを使用できます。

ネットワークで WEP 暗号化を使用しない場合は、None を選択します。

WEP を設定する手順は、次のとおりです。

手順

ステップ 1 設定しているプロファイルの Network Security エリアで、Encryption エリアに移

動します。
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ステップ 2 4 つの WEP key オプション ボタンのいずれかをクリックして、Encryption 設定

フィールドをアクティブにします。

ステップ 3 暗号化方式を選択し、適切なキーを入力します。

• ドロップダウン メニューから 40 Bit Encryption を選択します。WEP Key
フィールドに、10 桁のキーを 16 進数形式（0 ～ 9、A ～ F）で入力します。

例：ABCD123456

• ドロップダウン メニューから 128 Bit Encryption を選択します。WEP Key
フィールドに、26 桁のキーを 16 進数形式（0 ～ 9、A ～ F）で入力します。 

例：AB123456789CD123456789EF12

関連項目

• 電話設定値の設定（P.4-28）

• ユーザ プロファイルの設定（P.4-32）

• 電話帳の設定（P.4-37）

• 電話機のロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

電話設定値の設定

Phone Profile ウィンドウの Phone Settings タブを使用して、次の項目を設定でき

ます。

• 電話機の画面に表示されるメッセージのテキストの編集

• 呼び出しトーンの選択とカスタマイズ

• 次の高度な設定の使用

－ Cisco Discovery Protocol（CDP; シスコ検出プロトコル）のパラメータの

設定

－ ユーザ インターフェイスの言語の選択

－ ソフトキー設定の選択

－ バックライトの制御
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メッセージの編集と呼び出しトーンの選択

メッセージおよび呼び出しトーンを設定する手順は、次のとおりです。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Settings タブをクリックします。

ステップ 2 Greeting Message フィールドに、電話機を起動したときに表示されるテキスト（15

文字まで）を入力するか、編集します。

ステップ 3 Welcome Message フィールドに、電話機がスタンバイ モードのときに表示される

テキスト（10 文字まで）を入力するか、編集します。

ステップ 4 Ring Tone エリアでは、次の設定を使用して呼び出しトーンを設定する必要があ

ります。

• Current Ring Tone：Cisco 無線 IP 電話 7920 で現在設定されている呼び出し
トーンを表示します。デフォルトの呼び出しトーンには、Chirp 1 と Chirp 2
の 2 つがあります。

• Ring List (*.xml)：ローカルの XML 呼び出し音一覧ファイルを指定するには、
... ボタンをクリックして、目的の呼び出し音一覧ファイルを選択します。

• Ring Tone：ドロップダウン リストの矢印をクリックして、呼び出し音一覧
ファイルから目的の呼び出しトーンを選択します。

呼び出しトーン一覧に音量の大きな呼び出しトーンを追加する方法については、

P.7-17 の「大きな音の呼び出しトーンのダウンロード」を参照してください。
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高度な設定値の設定

Phone Settings ページの Advanced Settings セクションを使用して、電話機を制御

する次のオプションを選択できます。

CDP パラメータの設定

シスコ検出プロトコル（CDP）は、すべての Cisco ネットワーク機器上で実行さ

れるデバイス検出プロトコルです。各デバイスは、ブロードキャスト アドレス

に識別メッセージを送信し、他のデバイスによって送信されるメッセージを監視

します。

ネットワークで CDP を使用する場合は、次の手順に従って、電話機の CDP パラ

メータを設定します。

（注） シスコ製ではない装置を使用する場合、CDP パラメータを無効にできま
す。

手順

ステップ 1 Advanced Settings エリアで、Cisco Discovery Protocol チェックボックスをオンに

して、CDP パラメータをアクティブにします。

ステップ 2 CDP Time To Live フィールドに、電話バッファ内の CDP パケットが廃棄される

までの時間を秒単位（0 ～ 255）で入力します（デフォルトは 180）。

ステップ 3 CDP Transmit Interval フィールドに、Cisco 無線 IP 電話 7920 から CDP パケット

を送信する間隔（0 ～ 65535 秒）を入力します（デフォルトは 60）。
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ソフトキー設定の選択

ソフトキー設定では、電話機のアイドル中に表示されるソフトキー（PhBook ま

たは Services）を設定できます。Svcs は、電話機でのサービスを表します。

Call Up オプションを使用すると、電話機がコールに接続されたときに表示され

るソフトキーを設定できます。Mute ソフトキーを表示させたり、必要に応じて、

カスタマイズしたソフトキー テンプレートを割り当ててキーの順序を変えたり

することもできます。Cisco 無線 IP 電話には、ソフトキーが 2 つしかないため、

Cisco CallManager ソフトキーの前またはソフトキー テンプレートに表示されて

いるソフトキーの後に、Mute ソフトキーを表示するかどうかを選択する必要が

あります。

また、Cisco CallManager Administration で電話機を設定する際にこれらの設定値

を選択することもできます。Phone Configuration ページでは、Product Specific

Configuration のオプションを使用できます。Cisco CallManager 設定ファイルの設

定値は、設定ユーティリティからの設定値を上書きします。詳細については、

P.7-10 の「ソフトキー テンプレートの設定」を参照してください。

（注） Cisco 無線 IP 電話の右向き矢印を押すと、ソフトキー テンプレートで定義され

た Cisco CallManager ソフトキーをスクロールできます。 

これらの設定を変更する手順は、次のとおりです。

手順

ステップ 1 Advanced Settings エリアの Softkey Setting に移動します。 

ステップ 2 Idle フィールドでドロップダウン リストの矢印をクリックし、PhBook または

Services をクリックします。デフォルトの設定は PhBook です。

ステップ 3 Call Up フィールドでドロップダウン リストの矢印をクリックし、Mute または

Softkey from CM を選択します。デフォルトの設定は Mute です。
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言語の選択とバックライトの設定

電話機の画面に表示される言語の選択、およびバックライト オプションのオン /

オフの切り替えが可能です。 

これらの設定を変更する手順は、次のとおりです。

手順

ステップ 1 Advanced Settings エリアの Language に移動して、適切なオプション ボタンをク

リックし、ユーザ インターフェイスの言語を設定します。デフォルトの設定は

English です。

ステップ 2 Back Light フィールドで On または Off をクリックし、電話機のバックライト オ

プションを設定します。デフォルトの設定は On です。

関連項目

• ユーザ プロファイルの設定（P.4-32）

• 電話帳の設定（P.4-37）

• 電話機のロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

ユーザ プロファイルの設定

Phone Profile ウィンドウの User Profile タブでは、各電話機の個人プロファイル設

定値を設定できます。

事前定義されたユーザ プロファイルを使用することにより、電話機の呼び出し

音とトーンをすばやく変更できます。さまざまな作業環境で、次のプロファイル

が使用可能です。

• Normal

• Silent

• Meeting

• Outdoors
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たとえば、外で作業している場合、Outdoors プロファイルを選択すると、自動的

に呼び出し音量とスピーカ音量が大きくなります。Meeting プロファイルを選択

すると、呼び出し音量が一番低いレベルまで下がります。または Silent プロファ

イルを選択して呼び出し音をオフにできます。

表 4-3 は、ユーザ プロファイルのデフォルト設定値の一覧です。

 

ユーザ プロファイル設定のオプション

プロファイルのデフォルト設定値を使用したり、ユーザの必要に応じて設定値を

変更したりすることができます。

たとえば、Normal プロファイルを選択して、Warning Style を Tone から Vibrate

に変更することもできます。

個人プロファイルの変更

個人プロファイルのデフォルト設定値を変更する手順は、次のとおりです。

手順

ステップ 1 Phone Settings タブをクリックします。

ステップ 2 変更するプロファイルのボタンをクリックします。デフォルトまたは現在のモー

ドの設定値がそのプロファイルに対して表示されます。

表 4-3 個人プロファイルのデフォルト設定値

設定のタイプ

プロファイル

Normal Silent Meeting Outdoors

Speaker Volume 3 3 3 5

Ring Volume 4 0 1 6

Incoming Call Alert On Off On On

Vibrating Call Alert Off Off Off On

Keypad Tones Off Off Off On

Warning Style Tone Off Off Tone
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ステップ 3 Speaker Volume フィールドでスライダをクリックし、右に動かして音量を上げ

るか、または左に動かして音量を下げます。

ステップ 4 Ring Volume フィールドでスライダをクリックし、右に動かして音量を上げる

か、または左に動かして音量を下げます。

ステップ 5 Incoming Call Alert フィールドで On または Off をクリックして、警告オプショ

ンを有効または無効にします。オプションを無効にすると、電話機の呼び出し音

またはバイブレーションは機能しません。

ステップ 6 Vibrating Call Alert フィールドで On または Off をクリックして、バイブレーショ

ン オプションを有効または無効にします。コール警告に対して、呼び出し音と

バイブレーションの両方を有効にできます。

ステップ 7 Keypad Tones フィールドで On または Off をクリックして、キーバッドでキーを

押した時のトーンを有効または無効にします。

ステップ 8 Warning Style フィールドで、バッテリ残量が少ない場合、RF 信号強度が弱い場

合、またはボイス メッセージを受信した場合に警告するために、次のいずれか

のオプションを選択します。

• Tone：短いトーンを送信します。

• Vibration：短いバイブレーションを送信します。

• Off：警告オプションを無効にします。

関連項目

• Network Profile の設定（P.4-20）

• 電話設定値の設定（P.4-28）

• 電話帳の設定（P.4-37）

• 電話機のロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）
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電話機のロック パスワードの設定

セキュリティを高めるために、電話機にパスワード保護を設定できます。ユーザ

が Settings メニューと Phone Lock オプションを使用して電話機のロックを有効

にした場合、そのユーザは電話機をアクセス ポイントと関連付ける前にパス

ワードを入力する必要があります。 

Phone Profile ウィンドウの Phone Lock Password タブを使用して、次の設定を実行

できます。

• 電話機のロック機能の有効化または無効化

• 電話機のロック パスワードのデフォルトへのリセット

• 電話機のロック パスワードの変更

電話機のロックとパスワードの設定

電話機のロック機能を有効にする手順は、次のとおりです。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Lock Password タブをクリックします。

ステップ 2 電話機のロック機能を有効にするには、Phone Lock Enable チェックボックスを

オンにします。この機能はデフォルトで無効になっています。 

ステップ 3 Change Password チェックボックスをチェックします。

ステップ 4 New Password フィールドに、10 文字までのパスワードを入力します。パスワー

ドには 0 ～ 9 の数字、*、または # を使用できます。

ステップ 5 Verify New Password フィールドに、同じパスワードを再入力します。
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電話機のロック パスワードのデフォルトへのリセット

電話機のパスワードを消去する必要がある場合は、パスワードをデフォルト

（12345）にリセットできます。この手順でパスワードをリセットした場合、電話

設定データはすべてそのまま残ります。

パスワードをリセットする手順は、次のとおりです。

手順

ステップ 1 Phone Lock Password タブをクリックします。

ステップ 2 Reset Password to Default チェックボックスをチェックします。

（注） 電話機のロックを解除するデフォルト パスワードは「12345」です。これをユー

ザに通知する必要があります。

ロックされた電話機のロック パスワードのリセット

ユーザが電話機をロックし、そのパスワードを忘れてしまった場合、電話機の電

源がオンで、アクセス ポイントに関連付けられている場合に限り、管理者は電

話機のロック機能とパスワードを無効にできます。デフォルト パスワード

（12345）で電話機のロックを解除できない場合は、Cisco Technical Assistance

Center（TAC）に連絡をして、電話機を出荷時のデフォルト値に戻します。

注意 電話機を出荷時のデフォルト値にリセットすると、短縮ダイヤル、通話履歴、プ

ロファイル設定など、すべての電話設定値が削除されるので注意してください。

ネットワーク設定がデフォルト設定値にリセットされるので、電話機はアクセス

ポイントおよびテレフォニー ネットワークに到達できません。 
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関連項目

• Network Profile の設定（P.4-20）

• 電話設定値の設定（P.4-28）

• ユーザ プロファイルの設定（P.4-32）

• 電話帳の設定（P.4-37）

• 短縮ダイヤル ホットキーの設定（P.4-39）

電話帳の設定

Cisco 無線 IP 電話 7920 には、ローカル電話帳機能が備わっています。電話機の

Directory メニューを使用して、独自の電話帳エントリを追加できます。電話帳エ

ントリを使用すると、PhBook ソフトキーを押し、エントリの名前を検索し、Call

ボタンを押すことにより、コールを発信できます。 

Phone Profile ウィンドウの Phone Book タブにアクセスすることで、Cisco 7920 設

定ユーティリティを使用して電話帳エントリを追加、変更、および削除できま

す。さらに、共通の電話帳エントリのリストを作成し、カンマ区切り形式（CSV）

のファイルでそのリストを保存できます。CSV ファイルを電話機の電話帳にイ

ンポートしたり、電話機にある既存の電話帳エントリを CSV ファイルに保存し

たりすることができます。

電話帳エントリを使用する手順は、次のとおりです。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Book タブをクリックします。

Phone Book ウィンドウの下のセクションに、設定されている電話帳エントリが

表示されます。 

ステップ 2 新しいエントリを追加するには、次のフィールドに適切な情報を入力します。

• Name（20 文字まで）：エントリはアルファベット順にソートされるため、姓
を最初に入力するかどうかを決めてください。

• Office Number（23 桁まで）：ローカルの内線番号、またはアクセス コード
とエリア コードを持つ完全な電話番号を入力します。
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• Home Number（23 桁まで）：ローカル番号、またはアクセス コードとエリ
ア コードを持つ長距離番号を入力します。

• CellPhone Number（23 桁まで）：ローカル番号、またはアクセス コードとエ
リア コードを持つ長距離番号を入力します。

• Email Address（48 文字まで）：参照専用の E メール ID を入力します。

ステップ 3 Add をクリックして、電話帳にエントリを追加します。 

ステップ 4 既存のエントリを変更するには、スクロールして下のセクションにあるエントリ

を強調表示します。Edit Phone Book セクションに表示されたテキストを編集し、

Modify をクリックします。

ステップ 5 既存のエントリを削除するには、スクロールして下のセクションにあるエントリ

を強調表示します。Delete をクリックしてエントリを削除します。

ステップ 6 Load をクリックして、電話帳エントリを含む CSV ファイル（Phonebook.csv）を

インポートします。

ステップ 7 Save をクリックして、選択したディレクトリにある CSV ファイル

（Phonebook.csv）に既存の電話帳エントリを保存します。

関連項目

• Network Profile の設定（P.4-20）

• 電話設定値の設定（P.4-28）

• ユーザ プロファイルの設定（P.4-32）

• 電話機のロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）
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短縮ダイヤル ホットキーの設定

Cisco 無線 IP 電話 7920 ユーザは、電話機にローカルで保存されている 8 つの短

縮ダイヤル番号をプログラムできます。キーパッドの数字キー（2 ～ 9）を使用

して、短縮ダイヤル番号にアクセスします。数字キーの 1 は、ボイス メッセー

ジ システムへのアクセス用に予約されています。Menu > Directory > Phone

Book> Speed Dial を選択することで、短縮ダイヤル番号をプログラムできます。

Phone Profile ウィンドウの Speed Dial タブで、電話機の短縮ダイヤル ホットキー

を設定できます。また、電話帳エントリから短縮ダイヤル番号を選択することも

できます。

短縮ダイヤル ホットキーを設定または変更する手順は、次のとおりです。

手順

ステップ 1 Phone Profile ウィンドウで、Speed Dial タブをクリックします。

ステップ 2 数字キーに短縮ダイヤルを設定するには、Speed Button の番号の横にある Dial

Number フィールドに、ダイヤルする電話番号を正確に入力します。「9」または

「1」などのアクセス コードとエリア コードもすべて入力します。

ステップ 3 既存の番号を変更するには、Dial Number フィールドで変更します。

ステップ 4 電話帳にある電話番号を使用するには、Import from Phone Book ボタンを使用し

ます。 

関連項目

• Network Profile の設定（P.4-20）

• 電話設定値の設定（P.4-28）

• ユーザ プロファイルの設定（P.4-32）

• 電話帳の設定（P.4-37）

• 電話機のロック パスワードの設定（P.4-35）
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設定テンプレートの作成

現在の電話設定を Phone Profile ウィンドウにインポートして、データを設定ファ

イル テンプレートとして保存できます。設定ファイル テンプレートを他の Cisco

無線 IP 電話にエクスポートすることで、同じ設定で電話機を設定できます。

設定ファイル テンプレートを作成する手順は、次のとおりです。

ステップ 1 File > New を選択し、新規の Phone Profile ウィンドウを開きます。

ステップ 2 Import ボタンをクリックして、Cisco 無線 IP 電話 7920 から設定をインポートし

ます。

ステップ 3 P.4-18 の「Phone Profile ウィンドウ」を参照して、設定値を変更します。 

ステップ 4 設定ファイル テンプレートに設定値を保存します。 

a. File > Save As を選択します。

b. テンプレートの名前を入力します。

（注） ネットワーク セキュリティ設定（認証タイプ、WEP、LEAP）または電
話機のロック パスワードは、テンプレートに保存できません。

ステップ 5 設定テンプレート ファイルを、別の Cisco 無線 IP 電話 7920 にアップロードしま

す。 

a. 電話機に接続します。

b. 電話機にログインします。

c. Export ボタンをクリックします。 

ステップ 6 ネットワーク セキュリティ設定とパスワードは設定ファイルに保存されないた

め、これらの設定値を各電話機に入力します。
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Log History ウィンドウ

Cisco 7920 設定ユーティリティが起動されたとき、Log History ウィンドウは空の

状態で開きます。電話機で操作を実行すると、各タイプのイベントがキャプチャ

され、すぐに Log History ウィンドウに表示されます。 

この履歴ログは、設定ユーティリティを終了するときに、コンピュータのディス

クに保存されます。ログが存在している場合、デフォルトのファイル名

（logHistory.txt）の代わりにログ ファイル名を選択するよう要求されます。 

単純な ASCII テキスト エディタでログ ファイルを読むことができます。Log

History ファイルには、表 4-4 に示す項目が含まれます。

（注） ログ履歴に含まれる既存のエントリは、削除されたり、新規ログ エントリによ

り上書きされることはありません。新規ログ エントリは保存済みログ ファイル

に追加されます。

表 4-4 Log History ファイル情報

項目 考えられる値

Time mm.dd.yyyy/hh.mm.ss（PC のローカル時間）

Phone MAC 電話機のメディア アクセス制御（MAC）アドレス

Type • Import

• Export

• Configuration

Operation Type が Import の場合：インポートの設定

Type が Export の場合：

• エクスポート設定ファイルとそのエクスポートの設定

• アップロード設定ファイルおよび電話機のモデル番号と、

そのアップロード ファームウェア イメージ

Type が Configuration の場合：

• 「Save」と保存した設定ファイル名

• 「Save As」と保存した設定ファイル名

• 「Open」と開いた設定ファイル名
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Cisco 7920 設定ユーティリティのネットワーク接続のトラ
ブルシューティング

Cisco 7920 設定ユーティリティの使用時および Cisco 無線 IP 電話への接続時に

問題が発生した場合は、次の指示に従います。

他の TFTP アプリケーションを終了する

設定ユーティリティは TFTP のポート 69 を使用します。そのため、このポート

を使用しているアプリケーションがある場合は、設定ユーティリティを正しく作

動させるために、そのアプリケーションを事前に終了しておく必要があります。

PC のファイアウォールを無効にする

コンピュータでファイアウォールを使用している場合は、それを無効にして電話

機に接続する必要があります。

ネットワーク IP アドレスを確認する

PC から Cisco 7920 設定ユーティリティを起動するとき、ユーティリティは USB

インターフェイスから 192.168.1.x ネットワークへの接続を試行します。無線ネッ

トワークが 192.168.1.x ネットワークを使用していると、電話機の USB ポートを

有効にした後で、USB アダプタは Cisco 無線 IP 電話 7920 の設定のロードに失敗

します。

PC と 192.168.1.x ネットワークの間にネットワーク接続がないことを確認する手

順は、次のとおりです。

手順

ステップ 1 Cisco 無線 IP 電話 7920 で、Network Config > 802.11b Configuration > Wireless

Settings を選択します。

ステップ 2 Service Set Identifier（SSID）または認証モードを変更します。

ステップ 3 電話機の電源をオフにします。

ステップ 4 電話機の電源をオンにします。
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ステップ 5 USB を有効にします。

ステップ 6 必要に応じて、Cisco 7920 設定ユーティリティを使用して電話設定を変更しま

す。

関連項目

• 電話機への Cisco 7920 設定ユーティリティの接続（P.4-5）

• Cisco 7920 設定ユーティリティの使用方法（P.4-5）
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